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Comenzando LookoutDirect
Este capítulo explica cómo comenzar y seguir en LookoutDirect. Describe la pantalla de
LookoutDirect e introduce algunos atajos importantes del mouse y del teclado.

Registrándose en LookoutDirect
LookoutDirect se inicia seleccionando el menú LookoutDirect en Start>Programs.
Cuando usted instala por prtimera vez LookoutDirect la cuenta del administrador no tiene
ninguna contraseña. Cuando la cuenta del administrador no tiene ninguna contraseña,
LookoutDirect se abre sin requerir ninguna conexión. Entran como administrador
automáticamente.

·Nota: El servidor y las versiones run-time del cliente LookoutDirect se abren con la cuenta del usuario
NOBODY (nadie), no importa cualsea la contraseña que se haya configurado para la cuenta del administrador.

Una vez que usted proporcione una contraseña del administrador, LookoutDirect  le pide que
se registre (log in) antes de abrirse, con el cuadro de diálogo siguiente.

Entre la contraseña apropiada en el campo Password (contraseña) y haga clic en OK.
LookoutDirect no es sensible a mayúsculas o minúsculas en este caso.

Nota  Usted configura contraseñas con el User Manager de  LookoutDirect. Mientras la contraseña del
administrador esté vacía (es decir, si usted no inserta una propia), LookoutDirect entra siempre con el
administrador como el usuario, y no requerirá que ninguna persona se registre en  LookoutDirect. Esto puede
ser una gran conveniencia para un programador de procesos LookoutDirect, pero esté seguro de configurar
una contraseña de administrador antes de permitir a otros el acceso a su copia de desarrollo.Vea el capítulo
6, Seguridad, del Manual de Desarrollo de LookoutDirect para más información sobre el User Manager de
LookoutDirect, contraseñas, y seguridad de LookoutDirect en general.

El campo Idle Time determina cuánto tiempo de inactividad que LookoutDirect espera  antes
de salir desde el usuario corriente. Cuando configurado como 0, LookoutDirect deja logged
ON el usuario corriente hasta que ese usuario hace log OFF, un nuevo usuario logs ON, o
LookoutDirect se cierra.

Usted puede alterar contraseñas y crear o corregir cuentas y grupos de usuarios con el User
Manager (administrador de usuario), seleccionando  Options>User Manager.  Vea el capítulo
6, Seguridad, en el Manual de Desarrollo de LookoutDirect para una información más detallada
sobre el User manager y otras consideraciones de seguridad.
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Abriendo un archivo de proceso
1. Si usted tiene disponible un archivo de proceso de LookoutDirect, seleccione el menú

File>Open de la barra de menú de LookoutDirect. Usted puede mirar en  la carpeta  de
ejemplos para comenzar con procesos de muestra.

2. En el campo de datos Filename (nombre del archivo), teclee el nombre de un archivo de
proceso LookoutDirect (tienen  una extensión  de archivo . l4p), o elija un archivo de
proceso de la lista y seleccione OK.

Si usted selecciona un archivo de proceso válido, LookoutDirect abre el archivo y comienza
inmediatamente a ejecutar el proceso.

Cuando se abre un archivo de proceso, LookoutDirect selecciona menús disponibles adicionales
y muestra paneles de control  y la ventana de alarmas.

Usted puede abrir y hacer funcionar tantos archivos de  procesos simultáneamente como quiera
en LookoutDirect y los puede cerrar individualmente o todos juntos. Aunque no hay límite
superior teórico de cuántos archivos de proceso usted puede funcionar en una computadora, en
términos prácticos usted puede comenzar a ver funcionamiento degradado con un gran número
de procesos, dependiendo de sus recursos de hardware y de otras variables. Haciendo funcionar
múltiples instancias de LookoutDirect en una computadora, o distribuyendo procesos de
LookoutDirect en las computadoras en una red pueden aumentar el buen funcionamiento.

La Pantalla de LookoutDirect
LookoutDirect primero aparece en su pantalla como maximizado, tomando la pantalla entera.

LookoutDirect tiene dos modos Edit (de modificación) y RUN (funcionamiento). Usted puede
cambiar el modo entre ellos presionando las teclas <Ctrl-Espacio> en su teclado, o
seleccionando o sacando la selección a Edit mode en el menú de Edit. La ilustración en la página
siguiente muestra una pantalla de LookoutDirect en modo Edit.

Barra de Título
La barra de título en la parte superior de  la ventana de LookoutDirect muestra el nombre del
programa y el nombre del proceso actualmente activo. Si se maximiza un panel de control, el
nombre del panel de control aparece en la barra del título.

Barra de Menú 
La barra de menú muestra los comandos de menú disponibles, que cambian dependiendo de si
LookoutDirect está en modo RUN, modo Edit (de modificación), o está abierto sin ningun
proceso funcionando. Estos comandos pueden o no estar disponibles para el operador,
dependiendo del  nivel de  seguridad del operador.

Barra de estado
La barra de estado está en la parte inferior de la ventana LookoutDirect, según lo mostrado en
la figura 4-1. Cambia cuando sale o entra al modo Edit. Cuando no está en el modo Edit, la
barra de estado es gris y se muestra la hora y la fecha en el extremo izquierdo de la barra. El
nombre de cuenta del operador entrado viene después. Aparece en el centro el nombre de la
compañía según lo entrado durante el registro, y el estado de alarmas está en el extremo derecho
de la barra de estado. 
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Las flechas de navegación del panel de control pueden o pueden no estar visibles, dependiendo
de sus configuraciones de las opciones del sistema.

Cuando se está en el modo Edit la barra de estado se hace amarilla. Las coordenadas X e Y del
objeto actualmente seleccionado (si cualquiera) aparecen en el extremo izquierdo de la barra. La
anchura y la altura del artículo actualmente seleccionado vienen después. Aparece en el centro
el nombre, el nombre de archivo o la expresión del artículo seleccionado, y el estado de alarmas
aparece en el extremo derecho de la barra de estado.

Para entrar y salir del modo Edit, seleccione el modo Edit>Edit Mode, o apriete las teclas
<CTRL-Space >.

Espacio de trabajo de LookoutDirect
El espacio de trabajo de LookoutDirect es el área entre la barra de menú y la barra de estado. El
espacio de trabajo es el área en la cual usted ve y opera los paneles de control. La ventana de
alarmas también aparece dentro del espacio de trabajo. Usted organiza y arregla paneles de
control en esta área del espacio de trabajo.

En la figura 4-1, el espacio de trabajo de LookoutDirect contiene el explorador de objetos de
LookoutDirect (visible solamente cuando usted está  en el modo Edit) y el panel de control de
proceso Reader (lector).
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El espacio de trabajo visible en su pantalla es solamente una ventana en el espacio de trabajo
virtual de LookoutDirect. Si los paneles de control o sus iconos asociados están parcialmente o
totalmente fuera del espacio de trabajo visible, LookoutDirect muestra automáticamente barras
de scroll  horizontales y verticales a lo largo de la derecha y la parte inferior del espacio de trabajo
visible. Si las barras de scroll son visibles, usted puede rodar en el espacio de trabajo virtual para
ver todos sus paneles de control.

Object Explorer (Explorador de objetos)
El explorador de objetos de LookoutDirect es una herramienta útil para crear y corregir sus
procesos de LookoutDirect. Usted puede tener acceso a las funciones de correccion de
LookoutDirect desde esta ventana haciendo clic en el botón derecho en los objetos mostrados
allí (Las opciones cambian  dependiendo de en qué artículo usted haga clic). Usted puede
también crear procesos, objetos, carpetas dentro de procesos y luego organiza objetos
moviéndolos a partir de una localización a otra dentro de un proceso, crea objetos, arrastra
objetos mostrables y muestra expresiones a diversos paneles, y más.
Para usar el explorador de objetos de LookoutDirect, cerciórese de que LookoutDirect tiene un
proceso funcionando y que está en el modo Edit, después seleccione Object>Object Explorer.
La ventana inicial junto con un explorador algo ampliado de objetos se muestra en la ilustración
siguiente.
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Haciendo clic derecho dentro del explorador muestra un menú similar al siguiente.

Como usted puede ver, dependiendo de lo que usted seleccionó en el explorador antes de hacer
clic derecho en él, usted puede:

crear un objeto

modificar un objeto o procésarlo seleccionando Properties 

Colocar un nuevo nombre a un objeto o procéselo seleccionando Properties

borrar un objeto o una carpeta 

corregir conexiones de objetos o una base de datos de objetos 

configurar los permisos para una computadora, proceso, objeto o de seguridad 

hacer una colección de objetos 

Cuando usted crea un objeto mostrable en el explorador de objetos, aparece en la ventana del
explorador pero no en un panel de control. Para poner la parte mostrable de un objeto en un
panel de control, usted puede arrastrarlo y soltarlo. Si no hay componente mostrable al objeto,
LookoutDirect crea una expresión (si es posible).
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Si usted arrastra y suelta un objeto o miembro de datos a partir de un proceso a un panel de
control en otro proceso, LookoutDirect insiere una expresión para exhibir el valor representado.
Usted no puede poner la parte mostrable de un objeto en un panel de control en un proceso
diferente en que el objeto fue creado.

Cuando usted deja el modo Edit, se cierra la ventana del explorador de objetos de
LookoutDirect. El cambiar en Modo Edit restituye la ventana del modo del explorador en la
misma localización y en el mismo tamaño que tenía cuando usted salió del modo Edit.

Usted puede colocar un nuevo nombre a las carpetas y también volver a poner objetos con el
explorador de objetos de LookoutDirect.

LookoutDirect también tiene una herramienta llamada el navegador de conexiones, no mostrada
en la  figura, y usted puede utilizar para buscar las conexiones que usted hace entre los objetos.
Vea  la sección el navegador de conexiones más adelante en este capítulo para más información
sobre el navegador de conexiones.

Paneles de Control
Los paneles de control suministran una zona de visualización para cualquier grupo de
interruptores, perillas, gráficos de barras, indicadores digitales, gráficos de tendencia, y otros
componentes que usted desea utilizar para visualmente supervisar y controlar sus operaciones.
Los paneles pueden ser de tamaño plena pantalla, reducido al mínimo, o cualquier tamaño
entre esos dos. Usted puede mover los paneles alrededor de la pantalla “agarrando” la barra del
título de un panel con el cursor del mouse y arrastrándola a una nueva localización. Los paneles
de control  pueden también "aparecer"( pop-up) cuando ocurre un evento, por ejemplo, cuando
se presiona un botón  o cuando se activa una alarma. No hay límite en la cantidad de paneles
de control que usted puede crear o la cantidad de objetos mostrados en cualquier panel.

Cuando esté en el modo Edit usted puede tener acceso a algunas de las funciones de edición de
LookoutDirect haciendo clic en el botón derecho en un objeto o una expresión en el panel, o
en el panel mismo.

Hay tres tipos de paneles de control: normal, pop-up, y pop-up sin icono. 

Un panel de control normal se puede maximizar, colocar a tamaño normal, o reducir al mínimo
dentro del espacio de trabajo de LookoutDirect.

Un panel de control pop-up puede aparecer como en un estado pop-up o reducido al mínimo.
Cuando se muestra un panel de control pop-up, permanece encima del resto de los paneles hasta
que usted lo reduce al mínimo.

Los paneles de control no tienen un aspecto estándar. Usted puede modificar cada panel de
control para requisitos particulares para su estrategia particular de control con interruptores,
potenciómetros, y otros objetos gráficos. Algunos paneles de control pueden solamente mostrar
información, mientras que otros combinan información de control y de exhibición. 

La información exhibida representa siempre los valores más actuales disponibles a
LookoutDirect a través de la comunicación con sus aparatos de entradas y salidas.
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Con LookoutDirect usted tiene una considerable flexibilidad en cómo usted hace que se vea y
funcione el panel de control. Por ejemplo, usted puede dibujar sus propios interruptores y
substituirlos en lugar de los interruptores estándares. Usted puede hacer fácilmente que un
botón opere al revés de la manera como se espera  normalmente. Usted puede ser que le coloque
atrasos y condiciones en el panel que pueden no ser obvios solamente viendo el panel.

Los paneles de control son ventanas en el proceso que usted utiliza controlar el equipo accionado
interruptores, presionando los botones y dando vueltas a perillas. 

A diferencia de los interruptores y de las perillas verdaderos, usted puede asignar niveles de
seguridad a controles individuales, tan bien como los paneles de control enteros dentro de
LookoutDirect. Usted puede utilizar esta característica para impedir que algunos operadores que
no tienen niveles de seguridad  adecuados para aparatos específicos r=tengan acceso a estos. 

Vea el capítulo 6, Seguridad, del Manual de Desarrollo de LookoutDirect para más información
sobre seguridad.
A diferencia de los interruptores y de las perillas físicas, usted puede exhibir objetos de control
múltiples veces en un proceso dado usando exhibiciones múltiples, en el mismo panel de control
y en diversos paneles de control. Por ejemplo, cuando usted da vuelta a una perilla en una
localización, todas las copias de esa perilla giran al mismo tiempo, en cada localización de ese
control. El mismo objeto de control puede aparecer diferentemente en cada localización. Usted
puede ser que exhiba un potenciómetro como diapositiva horizontal en un panel, un par de
botones de incrementar y decrementar en otro panel, y una perilla en otro panel.
Usted puede tener la misma clase de operación síncrona entre controles en diversos procesos que
funcionan en su computadora, o entre controles que funcionan en procesos en diversas
computadoras en su red. El establecimiento de una red LookoutDirect hace esto posible, con
fuentes de posición y objetos remotos tales como Symbolic Link (conexion simbólica),
explicados posteriormente.

Ventana de Alarmas
Debajo del explorador de objetos de LookoutDirect y del panel de control del lector en la figura
4-1 está la ventana de alarmas. Usted puede elegir cómo se ve la ventana de alarmas
seleccionando Alarms>Display Options.  En la figura de abajo la ventana de alarmas está
configurada para exhibirse en la parte inferior del espacio de trabajo.
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Navegación y acciones de entradas del operador
Hay varios métodos para que los operadores de planta ajusten valores de referencia o cambien
de un panel de control a otro. Éstos incluyen el mouse, el Trackball, el touchscreen, y comandos
activados desde el teclado.

Cuando el cursor se mueve sobre un objeto controlable, el cursor se transforma en una mano,
indicando que usted ahora tiene control del objeto. Los objetos controlables incluyen elementos
tales como interruptores, potenciómetros y botones.
Al usar un teclado, las teclas de flecha mueven el cursor alrededor de la pantalla. La tecla < Tab
> salta el cursor a partir de un objeto controlable a otro, y la barra de < espacio > actúa como el
botón de mouse izquierdo, así que usted puede hacer clic en un objeto controlable sin realmente
usar un mouse.
Usted puede también relcionar teclas de función del teclado (F1, F2, etc.) a los paneles de
control y a otros objetos, así que usted puede cambiar entre los paneles de control o los
comandos de control de edición solamente presionando una tecla de función.

Teclado numérico virtual
Cuando usted está en modo RUN, usted puede hacer clic en un control digital del
potenciómetro y traer un teclado virtual para entrar valores numéricos, con un mouse o una
pantalla sensitiva al tacto.

Teclado alfanumérico virtual
LookoutDirect también tiene un teclado virtual que usted puede utilizar con una pantalla
sensitiva al tacto o un mouse.
Para activar el teclado virtual, seleccione Options>System y después para comprobar haga clic
en Left Mouse click (botón izquierdo del mouse) o en Right Mouse click (botón derecho del
mouse) en la sección del cuadro de diálogo Virtual Keyboard Pops Up.

Cuando esta característica está activada, haciendo clic en un campo de la entrada de datos o
tocando el campo en una pantalla sensitiva al tacto muestra el teclado virtual, según lo mostrado
en la figura siguiente.
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Connection Browser (Navegador de conexiones)
Use el navegador de conexiones para registrar  computadoras de red, navegar rápidamente entre
objetos, seguir las conexiones, identificar a orphans [huérfanos] (objetos inusitados), y organizar
objetos en un proceso.

Para tener acceso al navegador de conexiones, seleccione Object>Connection Browser.  Aparece
el cuadro de diálogo siguiente.

Vea la sección Registrando Computadoras en el capítulo 4, Creación de una red, en el Manual de
Desarrollo de LookoutDirect para información de como usar el browser de conexiones para
colocar las computadoras en red en LookoutDirect.

Para crear y para modificar objetos así como corregir las conexiones y la base de datos  en el
browser de  conexión, haga clic en el botón derecho sobre el objeto que usted desea modificar.

Usted puede también crear carpetas y mover objetos para dentro y para fuera de las carpetas.

Un cierto planeamiento de cómo usted desea arreglar los objetos en cada proceso, combinado
con un conocimiento de cómo trabaja la relatividad de trayectorias en LookoutDirect, puede
protegerle contra la mayoría de inconveniencias a este respecto. Vea el capítulo 5, Usando
LookoutDirect, para más información sobre cómo un cambio en la localización puede afectar
conexiones del objeto.

Para navegar las conexiones en los procesos LookoutDirect, LookoutDirect debe estar en el
modo Edit. Después de abrir el browser, haga clic en el nombre de la computadora local, y
seleccione el proceso que usted desea explorar. Se le presentará entonces una lista de objetos en
ese proceso.

Usted puede utilizar el navegador de conexiones para crear o para colocar el nombre
nuevamente  a carpetas dentro de su proceso, y usted puede mover objetos a partir de una
localización en otra interior un proceso dado, usando la técnica típica de arrastrar y soltar de
Windows.

Usted puede también crear nuevos objetos o corregir objetos existentes, las conexiones, o la base
de datos a través del browser de conexiones. Haga clic en el botón derecho en el browser de
conexiones para obtener el menú para elegir una de estas operaciones.
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Cuando usted selecciona un objeto individual para mostrar conexiones, su pantalla del
navegador muestra algo como la ilustración siguiente.

En este ejemplo, se ha seleccionado el objeto potenciómetro  nombrado Client_Pot1. Se
muestran todos los sitios y conexiones de exhibición, incluyendo la manera que este
potenciómetro es conectado remotamente con un miembro de datos en otro proceso.

Los iconos de los objetos $Alarm y Timer1 se descoloran en aspecto. Esto indica que este
objeto es un huérfano, significando que su salida no está siendo utilizada por ningún otro
objeto.

Haciendo clic en objetos de entradas o de salidas usted puede encontrar cadenas de conexiones
en sus procesos.  Haciendo clic en el botón derecho en un objeto o un parámetro, usted puede
modificar el objeto o el parámetro del navegador de conexiones.

Aunque usted puede explorar a partir de un proceso a otro cuando ambos procesos están
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abiertos en una computadora, usted no puede explorar a través de la red a un proceso que
funciona en otra computadora. El navegador de conexiones mostrará un objeto de red en la
pantalla, pero no puede explorar ese objeto.

LookoutDirect también tiene una herramienta adicional llamada Object Explorer (explorador
de objetos), que usted puede utilizar para seguir las conexiones que existen entre objetos. 

Vea a la sección Explorador de Objetos anteriormente en este capítulo para más información
sobre el explorador de objetos.

Opciones del navegador de conexiones
Usted puede simplificar la visión del navegador de conexiones seleccionando qué elementos son
mostrados en un objeto. Por defecto LookoutDirect está configurado para que sean permitidas
todas las configuraciones.

Haga clic en el botón Options (opciones) para activar el cuadro de diálogo de opciones del
navegador de conexiones, mostrada en la ilustración siguiente.

Si usted desea eliminar los parámetros del objeto (para centrarse en conexiones del miembro de
datos) inhabilite la opción de Show parameters (Muestre parámetros).

Inhabilite Show display objects (Muestre objetos de exhibición) saca todos los componentes de
exhibición desde la vista del browser de conexiones de un panel de control.

Inhabilitando Show constant connections saca todos los valores estáticos conectados con un
miembro del parámetro o datos del objeto. Inhabilitando esta opción puede ayudarle a centrarse
en variables y para cambiar  valores originados en otros objetos.

Seleccione Save settings on exit para salvar las opciones configuradas para el navegador de
conexiones la próxima vez que usted abre el navegador en una sesión de LookoutDirect.

Seleccione Play sound effects (efectos sonoros) permite que el sistema de Windows genere
sonidos de alarmas cuando usted hace una operación ilegal en el navegador de conexiones.
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Archivos de aplicaciones de LookoutDirect
Usando LookoutDirect usted puede desarrollar rápidamente un archivo de proceso completo.
Todo el desarrollo es interactivo. Usted no tiene que programar o compilar. Solamente cree los
objetos y conéctelos según lo que necesite. El ciclo de desarrollo crea cuatro archivos únicos para
cada uso: un archivo de proceso, un archivo del código de fuente, un archivo de estados y un
archivo de seguridad.

Si usted desarrolla un proceso LookoutDirect en una computadora y desea hacerlo funcionar en
otra computadora, usted debe copiar los archivos de proceso (l4p) y de seguridad (lka) a la
computadora nueva para que su proceso funcione correctamente.

Usted puede también copiar los archivos de fuente y de estado, si usted desea, pero
LookoutDirect puede reconstruir estos archivos en la nueva localización en caso de necesidad.

Archivo de proceso 
Un archivo de proceso es un archivo compilado que contiene el proceso LookoutDirect que usted
desea hacer  funcionar. Es actualizado cada vez que usted selecciona el comando File>Save. 

Los archivos de proceso son archivos binarios con  una extensión del nombre de archivo l4p
(proceso de LookoutDirect). Usted no corrige ni modifica directamente archivos de proceso con
un editor de textos. Mas bien, LookoutDirect compila  el archivo l4p objeto por objeto mientras
usted crea cada objeto. Con esta forma de operación usted puede permanecer en línea mientras
crea, actualiza, o modifica su aplicación. 

No hay necesidad de cerrar el proceso. LookoutDirect no detiene la operación mientras usted
agrega o borra controladores, entradas o salidas, gráficos, o modifica su lógica. 

Se recomienda que usted salve el proceso a menudo mientras hace modificaciones, de modo que
usted no pierda cambios en el evento de un apagón.
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Archivo del código fuente
LookoutDirect también actualiza automáticamente un archivo correspondiente del código
fuente cuando usted invoca el comando File>Save. LookoutDirect puede compilar este archivo
para crear un archivo .l4p, para incluir definiciones del objeto, nombres, la configuración de
las entradas y salidas, comunicaciones, lógica de control, la disposición del panel de control y
otros parámetros de objetos.

Los archivos del código fuente tienen una extensión del nombre de archivo .lks (fuente de
LookoutDirect). Éstos son los archivos de texto estándares ASCII que usted puede imprimir o
ver con cualquier procesador de textos o editor de textos. Usted puede utilizar esta información
para el propósito de eliminar errores y de documentación.

Nota  Ya que el formato binario de archivos de  proceso de LookoutDirect ambos pasados y futuros pueden
cambiar por razones de eficiencia, usted debe siempre mantener con un respaldo los  archivos  fuente  lks.
Éste es el archivo que usted compila para abrir un proceso creado en una versión más antigua de
LookoutDirect con cualquier nueva versión de LookoutDirect emitida en el futuro.

Usted puede compilar los archivos fuente de LookoutDirect con el comando Open, o
manualmente, con una ventana DOS.

Para abrir y para compilar un archivo fuente dentro de LookoutDirect seleccione File>Open.  Se
abre el cuadro de diálogo siguiente.

Configure File of Type (archivos del tipo)  a LookoutDirect Source Files (*.lks)  y seleccione el
archivo fuente que usted desea compilar.
Para compilar un archivo fuente  de LookoutDirect manualmente, consulte las instrucciones en
el apéndice B, el compilador CBL, en el Manual de Desarrollo de LookoutDirect.
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El archivo de estados
El archivo de estados contiene los valores corrientes de los miembros de datos de objetos. Estos
valores incluyen referencias y otros datos importantes mantenidos dentro y usados por los
objetos. 

Usted puede pensar en el archivo de estados como una memoria permanente para las
referencias y graficos de tiempo real en LookoutDirect. LookoutDirect usa el archivo de estados
para almacenar el estado de interruptores, de potenciómetros, y de líneas de graficos de
tendencia. Cuando LookoutDirect primeramente carga una aplicación, lee el archivo apropiado
de estados para determinar en qué estado deben estar los potenciómetros, los interruptores,
gráficos de tendencia, etcétera durante la partida.

El archivo de estados se actualiza en cualquier momento que usted salva, cierra o sale del
archivo de la aplicación LookoutDirect. Puede también actualizarse periódicamente según lo
definido en el cuadro de diálogo de las propiedades de proceso o el objeto Loader (cargador).
Usted invoca este cuadro de diálogo seleccionando el comando de menú de de File>Modify
Process. Los archivos de estados tienen  una extensión de nombre del archivo  .l4t (estado
de LookoutDirect).

Archivo de seguridad 
Cada proceso LookoutDirect tiene un archivo de seguridad anexado, identificado por  la
extensión  .lka. 

Toda la información de seguridad para un proceso de LookoutDirect se mantiene en el archivo
.lka para ese proceso. Usted debe mantener el archivo . lka en el mismo directorio que el
archivo .l4p para que trabajen las configuraciones de seguridad. Si usted pierde  el archivo
.lka, todos los usuarios tendrán acceso completo a todas las partes del proceso. Para
reconstruir el archivo, usted tendría que configurar todos los permisos de seguridad
nuevemente.

Vea el capítulo 6, Seguridad, del Manual de Desarrollo de LookoutDirect para una información
más detallada sobre seguridad de LookoutDirect.



Configuración de Atajos

Atajos de mouse
Este manual hace referencia a varios atajos que se usan con el mouse.

Es fácil familiarizarse con los comandos del mouse y el ayudará a desarrollar sus aplicaciones.

Nota: Ud puede seleccionar varios items en un panel haciendo clic en un panel y arrastrando el cuadro que
aparece alrededor de los objetos que quiere seleccionar.  Los comandos que siguen afectarán el grupo
entero o puede saltar de un item al próximo, avisándole a Ud de que se necesitan nuevas instrucciones.
Ud. puede parar este proceso en cualquier momento manteniendo la tecla <SHIFT> apreatra y
seleccionando los botones OK o Cancel en el cuadro de diálogo corriente.

Manual de cómo comenzar LookOutDirect

Capítulo 4: Fundamentos básicos de LookoutDirect

4 - 16

1

2

4

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

Función Acción de mouse

Seleccione un objeto, símbolo gráfico,
texto, expresión o cualquier item en
un panel.

Haga clic: Seleccione el item apuntando el cursor al
item y haga clic con el botón izquierdo del mouse
(vea la nota mas abajo) 

Cree un nuevo objeto desde un
objecto existente 

Arrastre + CTRL: Seleccione el o los items con el
cursor y haga clic con el botón izquierdo del mouse.
Mantenga la tecla CTRL apretada y arrastre el item
selecionado. Esto hace una nueva instancia del
objeto:
Arrastrando Pot1 con la tecla CTRL apretada creará
un nuevo objeto nombrado Pot2.

Copie un objeto, símbolo gráfico,
texto, expresión o cualquier item en
un panel.

Arrastre + SHIFT: Seleccione el o los items con el
cursor y haga clic con el botón izquierdo del mouse.
Mantenga la tecla SHIFT apretada mientras arrastra
el item selecionado. Esto hace una copia del objeto
selecionado que es conectado al original. Ambos
objetos tienen el mismo nombre.

Modifique parámetros de objetos de
un objeto, símbolo gráfico, texto,
expresión o cualquier item en un
panel.

Haga clic en el botón derecho: Seleccione el item a
ser modificado. Apunte el cursor al item y haga clic
con el botón derecho del mouse 



Recordando nombres de Objetos 
Muchas cajas de diálogo contienen campos de expresión. Los campos de expresión son amarillos
e indican que usted puede obtener ayuda identificando o recordando un nombre de objeto y a
miembros asociados de datos presionando el botón derecho del mouse (haga clic en el botón
derecho en el campo seleccionado de la expresión).

Asuma, por ejemplo, que usted desea hacer un promedio de un cierto valor. Usted comienza a
crear una expresión para este valor, pero usted no puede recordar el nombre del miembro de
datos o del objeto del que usted desea tener un valor medio. Haga clic en el botón derecho en
el campo de la expresión (el campo en el cual usted teclea normalmente el miembro de datos
que usted desea conectar o exhibir).

Cuando usted hace clic en el botón derecho en cualquier campo de la expresión, LookoutDirect
presenta el cuadro de diálogo Revise Expression (revisión de la expresión), según lo mostrado
en el diagrama siguiente.

Figura 4-2. Redactor de expresión activado haciendo clic en el botón derecho en la zona amarilla 
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Usando el redactor de expresión, usted puede copiar fácilmente a nombres de objetos y a sus
miembros de datos directamente en el campo de la expresión. Navegue a través de procesos y de
objetos hasta que usted haya seleccionado el miembro de datos del objeto que usted desea.
Cópielos en la zona de informaciones del redactor de expresión, haciendo clic en el botón Paste
o haciendo clic doble en el miembro de datos. Haga clic en OK, y LookoutDirect escribe la
expresión en la zona de informaciones de expresión del objeto, tal como el campo Data en el
cuadro de diálogo Create Average Object (Cree el objeto del promedio) mostrada en la
ilustración siguiente.

Nombres de trayectorias en LookoutDirect
En versiones antes de LookoutDirect 4.0, usted podría solamente tener un proceso funcionando
en cualquier instancia de LookoutDirect, y no había carpetas en un proceso para organizar
objetos. La creación de una red era hecha a través de DDE, que utilizaba trayectorias específicas.

En LookoutDirect 4 y más nuevo, la relación entre los objetos que funcionan en diversos
procesos en diversas computadoras es más flexible y potencialmente más complicada. Cuando
usted insiere una expresión en un panel de LookoutDirect o hace una conexión a o entre
miembros de datos, usted puede ser que exhiba un valor que viene del proceso conteniendo ese
panel.  Puede ser que también quiera exhibir un valor que viene de otro proceso que funciona
en la misma computadora o de un proceso que funciona en otra computadora en la red.

Una trayectoria puede ser absoluta, comenzando con el nombre completamente cualificado de
una red de computadoras y conducir a través de directorios y de subdirectorios jerarquizados a
un solo objeto; o relativo, mandando a la computadora para buscar un objeto en un cierto
directorio definido no de la computadora, sino concerniente a la carpeta corrientemente activa.

Para suministrar máxima flexibilidad de programación, usted puede utilizar una gran cantidad
de niveles de relatividad, o modos de relatividad de la trayectoria, configurando la trayectoria a los
datos cuando usted crea una expresión. Estos modos funcionan en forma muy similar a otras
trayectorias relativas usadas en operaciones de DOS, células de hojas de cálculo como EXCEL,
y las direcciónes de Internet.
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Usted puede configurar una trayectoria para cada objeto o conexión individual, usando un nivel
diferente de relatividad. Estos modos de relatividad de la trayectoria incluyen:

Relativo (por defecto  de LookoutDirect)

Relativo  al proceso 

Relativo  a la Computadora 

Absoluto 

El nivel de relatividad de la trayectoria que usted elige hace una diferencia en cómo su proceso
funciona cuando está copiado o es movido a otra computadora. Por ejemplo, suponga que usted
tiene un funcionamiento de proceso del cliente en la computadora Alfred que refiere a objetos
en un proceso del servidor también que funciona en la computadora Alfred. Si usted funciona
ese proceso del cliente en la computadora Bert, ¿se refiere a objetos en la computadora Alfred o
la computadora Bert?

Configurando el nivel de relatividad de la trayectoria es la forma cómo usted puede controlar a
qué objetos se refieren sus procesos. El punto principal a recordar sobre modos de relatividad de
la trayectoria en LookoutDirect es que los modos se distinguen por el prefijo de la trayectoria.

En modo relativo, la forma de la trayectoria es: 

object

o 

folder\object sin prefijo.

El modo relativo es el modo por defecto en LookoutDirect 4. Todas las trayectorias son relativas
a la carpeta o al proceso que contiene la expresión que usted está creando o al objeto usted está
conectándose.Use el modo relativo al conectar los objetos que deben ser agrupados juntos y que
se deben copiar o moverse como grupo.

Las conexiones entre los objetos en una carpeta deben utilizar modo relativo de modo que
puedan ser copiadas y movidas a otra parte mientras mantengan la misma  relación entre cado
uno.

El modo relativo de proceso es indicado por un solo backslash como prefijo (\) seguido por un
nombre de carpeta o del objeto, como en:

folder\......folder\object 

Use el modo relativo de proceso cuando usted desea hacer una conexión entre dos objetos en
diversas carpetas en el mismo proceso.

El modo relativo de  computadora es indicado por un prefijo que consiste en dos backslashes), un
punto y un backslash  (\\.\) seguido por un nombre de proceso, como en 

\\.\process\folder\…folder\object 

Use el modo relativo de computadora cuando usted desea referirse a otros procesos que funcionan
en la misma computadora.
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Por ejemplo, si usted tenía un proceso llamado  Station_Control que llamó una cantidad
de otros procesos por nombre en la computadora Alfred, usted podría utilizar que el mismo
proceso  Station_Control en la computadora Bert, para referirse a los procesos
idénticamente nombrados que funcionaban en la computadora Bert.

El modo absoluto es indicado por dos backslashes  (\\)  seguidos por una trayectoria completa de
la red, como en:

\\computer.place.com\process\folder\…folder\object 

El modo absoluto es, de hecho, un modo de URL. Use modo Absolute cuando usted desea
referirse a un proceso particular en una computadora particular. Cualquier referencia a un PLC,
por ejemplo, debe ser en modo absoluto para referirse siempre a la computadora conectada
físicamente con ese PLC; no importa donde está funcionando el proceso en referencia

Nota:  Aunque el modo relativo es el modo por defecto de  LookoutDirect, cuando usted utiliza un objeto fuera
de la localización inmediata de su expresión, la trayectoria llega a ser más específica. Agregando dos puntos
(..) al principio de una trayectoria, por ejemplo, se puede utilizar para especificar al parent de la primera
carpeta enumerada.

La razón de manualmente cambiar un modo de trayectoria a un nivel más allá de lo  necesario
en su caso actual es asegurarse de que su proceso trabaja correctamente si usted lo cambia,
totalmente o parcialmente.
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